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1 Introduction 

Revit is well known for Building information modelling (BIM) and SCIA Engineer for structural 
information modelling (also for Finite Element Method (FEM) analysis and design). This section 
explains the overall concept of the link between these two programs. 

1.1  BIM and the Structural/Analytical Model 

 The picture below explains the high level flow between the BIM and a typical structural analysis 
software. 

 

 

 

The Architect creates the architectural model in Revit (or imports it into Revit having created it in some 
other application) without having to be concerned about the structural aspects. When the 
architectural model is complete, it is passed to the structural engineer. The structural engineer 
updates the Revit model and modifies it from a structural point of view. Revit generates/maintains 
the analytical model (also known as the mathematical model or FEM model) as shown in the example 
below. 
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 Revit model showing the physical member ----------- Analytical lines of the member 

 

 

 Revit Model – Analytical model view   ------------  Exported Model in SCIA Engineer 

 

The analytical model from Revit is transformed into a finite element model inside SCIA Engineer. 

Note: In Revit 2023, the analytical model feature has been modified significantly. The approach for 
generating the analytical model is now changed from “Derived analytical model” to “Contextual 
analytical model”. For more details about Structural analytical modelling in Revit, please visit the link 
here. 

https://knowledge.autodesk.com/support/revit/learn-explore/caas/CloudHelp/cloudhelp/2023/ENU/Revit-WhatsNew/files/GUID-5C2D9046-20BC-4C6F-B951-9D5F33CED1C8-htm.html
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2 Bi-directional link – Revit and SCIA Engineer 

This link software supports a bi-directional link between Revit and SCIA Engineer. 

2.1 Items supported in the program: 
 

Item in Revit Item in SCIA Engineer 

1 Structural Columns Column (1D member) 

2 Structural Framing : Beam 1D member 

3 Structural Trusses 1D members  

4 Structural Framing : Brace 1D member 

5 Structural Beam system 1D members 

6 Wall : Structural 2D member 

7 Floor : Structural 2D member (Slabs/Load panels) 

8 Analytical Members 1D members 

9 Analytical Panels 2D members  

10 Holes in slab or wall Openings in the 2D member / Openings as panels in 2D 
members 

11 Holes in Beam web Openings in the 1D member 

12 Structural Foundation : Wall Fixed line support 

13 Structural Foundation : Slab 2D Element / Slab + subsoil / Line or point support 
depending on structural element supported 

14 Boundary Conditions Support 

15 Point Load Free point force 

16 Line Load Free line force 

17 Area Load Free surface force 

18 Hosted Point Load Point force in node 

19 Hosted Line Load Line force on 1D member 

20 Hosted Area Load Surface force on 2D member 

21 Load cases with load nature 
"dead", "live", "wind" etc. 

Load cases with load groups using appropriate load type 

22 Load Combinations Load combinations 

23 Grouped Revit Structure objects None 

24 User defined families for Frames 
and Columns 

Cross sections according to user mapping / General cross 
sections / Numerical section 

25 Composite floor Composite slab 

26 Floor with metal deck Metal deck 

27 Levels Stories (only from SCIA Engineer to Revit) 
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28 Structural Area Reinforcement 2D Reinforcement (only from SCIA Engineer to Revit) 

29 Reinforcement in frames and 
columns 

Reinforcement. (When exported from Revit to SCIA Engineer 
it is exported as PRAD reinforcement.)  

30 Analytical link Rigid arm 

2.2 Items not supported in the program: 
 

Item in Revit Item in SCIA Engineer 

1 None Shell 

2 User defined family forming more than one 
profile 

None 

3 1D Grid None 

4 Web stiffeners Web Stiffeners 

2.3 Structural usage support: 

Revit classifies its structural elements based on the function of the member but SCIA uses a different 
naming convention for the “Member type” property. The following table lists the mapping between 
SCIA Engineer and Revit: 

  Item in SCIA Engineer Item in Revit 

1 Member type = Column Structural Columns / Analytical Members 

2 Member type = Beam Structural Framing – Beam / Analytical Members 

3 Member type = Wall Bracing Structural Framing -Vertical Bracing / Analytical 
Members 

4 Member type = Roof Bracing Structural Framing - Horizontal Bracing / Analytical 
Members 

5 Member type = General Inferred based on direction of member 
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3 Analytical model in Revit 

3.1 Derived Analytical model: 

Revit used this method until the version 2022 to handle analytical elements. The analytical model is a 
special representation of the physical model with additional information required for structural 
calculations. This could be turned on or off from the Enable Analytical Model option.  

Once the analytical element is turned on, properties that are relevant for structural analysis and 
design, like boundary conditions, end fixities (hinges), member end forces and loads can be assigned 
to the analytical model. 

Revit link relies heavily on this analytical model and works by reading all the properties from this 
analytical model and sending it to SCIA Engineer.   

3.2 Contextual Analytical model: 

Revit 2023 shifts to a new system called the Contextual analytical model. A new class of structural 
elements are introduced that are no longer derived from or necessarily coupled to the physical 
elements. Instead, it is now possible to create analytical elements independent of the physical 
member, or even in the absence of one. Once an analytical element is created, it can be associated to 
any physical member but it is not essential.  

Some properties that were earlier a part of only the physical member (like materials, cross sections, 
etc.) can now be associated with the analytical member too.  

3.3 Creating analytical elements in Revit 2023 

When a physical model is present, the user can use the Analytical automation tool to generate 
analytical elements from physical members.  

 

 

This tool is a Dynamo script, which generates the analytical elements from the physical model. 
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Alternatively, individual analytical elements may be created by using the Analytical member or 
Analytical panel command. Once created these elements may be associated with physical members, 
or left as they are without any association with a physical member.  

 

3.4 Derived vs Contextual analytical model: 

 Derived analytical model Contextual analytical model 

Analytical member Analytical model is created from 
physical elements. It is enabled by 
setting the option “Enable analytical 
model” to true.  

Analytical model can be created 
separately.  
Analytical automation tool 
developed in dynamo can be used 
to generate the analytical model. 

Association with physical 
model 

Coupled with physical model. Analytical 
model cannot exist without physical 
model. 

Analytical model can exist 
independently and may or may not 
be associated with a physical 
model. 

Geometry Some properties like position, size, etc. 
are different from the physical model.  

Can be completely Independent of 
physical model. 

Cross-section Uses the same cross-section as physical 
model 

Independent of physical model. 

Material Uses the same material as physical 
model 

Independent of physical model. 

Eccentricities Eccentricities are referenced from the 
position of the physical member. 

-NA- 

Other properties – Camber 
size, Number of studs 

Read from physical model -NA- 
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4 User interface and commands 

CADS Revit SCIA Engineer Link is available in the main Revit ribbon under then CADS ribbon group 

 

4.1 Export to SCIA Engineer 

This section explains how a Revit model can be exported into SCIA Engineer.  

It is recommended to use the “structural template” for creating the Revit model. If you work with the 
Eurocode, then you should select the appropriate Eurocode template as illustrated below.  

 

The screenshot below is an example of a model created using Revit. 

 

Once the project is created, it has to be saved before exporting into SCIA Engineer. The program will 
prompt with the file save dialog if the project has not already been saved.  
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There are two ways you could initiate the export of a Revit structural model to SCIA Engineer. 

The first is,  

Revit -> CADS -> CADS Revit SCIA Engineer Link -> Options-> Export to SCIA Engineer 

The second option is to use the Review & Export / Export option.  

Revit -> CADS -> CADS Revit SCIA Engineer Link -> Export 
 

 

This option allows the export of the Revit model into SCIA Engineer using the current user options.  

The picture below shows the exported SCIA Engineer model for the previous Revit example. 

 

4.2 Import SCIA Engineer model into Revit 

This section explains how a model in SCIA Engineer model can be imported into Revit. Before you start 
the import of the model from SCIA Engineer, you need to create a blank Revit document using the 
“Structural template”. Choose the structural template from the standard Revit templates according 
to the National code.   

The Revit project has to be saved before importing the SCIA Engineer model. The program prompts 
the user with the file save dialog if the project has not already been saved.  

You can import a SCIA Engineer model into Revit using the Review & Import / Import option. 
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There are two ways you could import a SCIA Engineer model into Revit: Direct exchange and File 
exchange.  

If you have chosen “Direct exchange”, the model currently open in SCIA Engineer will be imported into 
Revit.  

Revit -> CADS -> Revit SCIA Engineer Link -> Import 

 

In order to use the “file exchange” method, you will need to export the SCIA Engineer to an .r2s file 
format first. This could be done from inside SCIA Engineer by choosing File -> Export -> Revit file. Once 
this file is saved you will need to choose the below option: 

Revit -> CADS -> CADS Revit SCIA Engineer Link -> Options-> Import from SCIA Engineer 

You will be prompted to select the .r2s file which you created and the model from the selected file 
will be imported into Revit.  

In both kinds of exchange, the details of the members imported, warnings and errors if any will be 
listed in the log file. 

4.3 Options 

The following dialog is displayed when the “Options” command has been selected from the toolbar. 
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Actions 

National code 

The national code option specifies which National Code is to be used in SCIA Engineer. 

The following National Codes are supported: 

  

Note: 

The material mapping is dependent on the National Code and hence it is important to select the 
correct National Code. 

The link program does not validate the national code used in the Revit template and the national code 
selected in the Options dialog. Hence it is important that you chose the correct national code. For 
example, if the user has modelled using the Canadian template and tries to export using the EC-EN 
national code, the program may not work as expected. 

Mode of Export 

The Mode of Export can be set in this dialog. 

  

These options work differently depending on the context in which they are used.  

If the model is exported from Revit, the option “Mode of Export = Direct Exchange” launches SCIA 
Engineer and exports the model into it.  

When importing from SCIA Engineer, the option “Direct Exchange” reads the active SCIA Engineer job 
and updates the current Revit model.  

The option “Mode of Export = File Exchange” writes the analytical model data as a SCIA Engineer Revit 
file (e.g. model.R2S) which can be opened/imported into SCIA Engineer using the command “Import 
 Revit File.” 

Note:  

The File Exchange option does not require SCIA Engineer to be installed in the computer and allows 
the sending of this file to other users who have the full version of SCIA Engineer installed. 
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Export to SCIA Engineer 

Selecting “Export to SCIA Engineer” exports the Revit model into SCIA Engineer. Selecting the “Import 
from SCIA Engineer” imports the SCIA Engineer model into Revit or updates the Revit model from SCIA 
Engineer. 

  

Create New 

By default, the “Export to SCIA Engineer” will update if any existing SCIA Engineer file with the same 
name is available in the folder. 

If you select “Create New”, then the existing SCIA Engineer file with the same name in the folder is 
deleted and a new SCIA Engineer file is created (if it is not already opened in SCIA Engineer). If it is 
already opened in SCIA Engineer, it cannot overwrite the file and a warning message is being displayed. 

  

Options and filters 

Filtering options allow the user to ignore certain items so they are not exported from Revit. 

  

Export 

Elements to export: This option allows you to specify the type of elements to export to SCIA Engineer. 
The options available are: 

 All analytical – All analytical elements are exported to SCIA Engineer irrespective its 
association with the structural model. The elements will be exported to SCIA Engineer based 
only on the analytical member properties. Boundary conditions, member end fixities, and 



Revit SCIA Engineer Link - Help 

12 
 Copyright © Computer and Design Services Limited 

loads if defined in Revit will be exported. If this option is selected, the link will not read any 
structural elements or properties from structural member.  

 All structural - All structural elements are exported to SCIA Engineer irrespective its 
association with the analytical model. The elements will be exported to SCIA Engineer based 
only on the structural member properties. Boundary conditions, member end fixities, and 
loads if defined in Revit will not be exported. If this option is selected, the link will not read 
any analytical elements. 

 With both analytical and structural – The structural members which are associated to the 
analytical members are only exported to SCIA Engineer. If this option is selected, the link will 
not export the members with only structural or analytical elements. The geometry of 
members and the properties like material, cross-section and section rotation will be read from 
analytical model and the additional properties like alignment, composite deck info are read 
from structural properties. Boundary conditions, member end fixities, and loads if defined in 
Revit will be exported.  

 All - All elements in Revit are exported to SCIA Engineer. If the structural members are 
associated with analytical members, the properties of analytical model will take the 
precedence. 

Please note that, the option specified during export will become read-only after successful export. To 
change the option, you have to export the model by setting the option “Create New” to true. 

Only selected elements - This option allows you to export only the selected members from Revit to 
SCIA Engineer. This selection filter is applied based on the option chosen in “Elements to export” 
option. 

Foundation slabs will be exported as specified. The “Default” option exports foundation slabs as set in 
the Revit properties. This option will not be available if the “Elements to Export” option is set as “All 
analytical”. 

Export elements based on layers – If this option is set to “Yes”, the elements will be exported to SCIA 
Engineer in different layers based on their category and the layer mapping. The category includes the 
frames, columns, plates and walls and the user could specify the layer names for each of these types.  

Setting this options “No” will export all the elements into the default layer in SCIA Engineer. In the 
roundtrip, if you would like to retain the layer info for the models imported from SCIA Engineer, set 
this option to “No”. 

Openings as panel – Setting this option “yes” will export the openings in slabs as “Panels in slabs”. If 
this option is set to “No”, the openings will be exported as openings. 

Export reinforcement as PRAD – If this option is set to “Yes”, the reinforcements modelled in 1D 
members will be exported to SCIA Engineer as “PRAD” reinforcement. Beams with rectangle, T and L 
cross-sections and columns with rectangle and circular sections are supported. If you don’t need the 
reinforcements to be exported, set this option to “No”. This option will not be available if the 
“Elements to Export” option is set as “All analytical”. 

If the “Internal edges with beams” is set to “Yes”, internal edges in the SCIA Engineer model will be 
created for slabs at beam locations. 

Export / Import 

Ignore loads - If this option is set to “Yes”, the loads are not considered for both export and import. 
This option will not be available if the “Elements to Export” option is set as “All structural”. 



Revit SCIA Engineer Link - Help 

13 
 Copyright © Computer and Design Services Limited 

Ignore load combinations – If this option is set to “Yes”, the loads combinations are not considered 
for both export and import. This option will be available only if the option “Ignore loads” is set to 
“False”.  

Ignore walls - If this option is set to “Yes”, walls are not considered for both export and import. 

Ignore slabs - If this option is set to “Yes”, structural slabs are not considered for both export and 
import. 

Ignore member release - If this option is set to “Yes”, member end releases are not considered for 
both export and import. This option will not be available if the “Elements to Export” option is set as 
“All structural”. 

Ignore supports - If this option is set to “Yes”, the Boundary conditions are not considered for both 
export and import. This option will not be available if the “Elements to Export” option is set as “All 
structural”. 

Ignore load panels – If this option is set to “Yes”, the load panels are not considered for both export 
and import.  

Group sections based on length – If this option is set to “All sections”, the families are grouped based 
on their length. During export, for each group, a section is created in SCIA Engineer. If this option is 
set to “Circular hollow sections only”, the families with section shape “circular hollow sections” are 
grouped based on their length. By default, the option is set to “No”.  

This option is applicable only for families with steel materials. This option is primarily intended to be 
used in the export/import of scaffold models (where members of the same cross section may need to 
be grouped based on their length). 

If the option “Ignore loads” and “Ignore load combinations” are both set to “Yes”, and the option 
“Analysis Results” is set to “No”, the loads cases too will not be imported. In all other cases, the load 
cases will be automatically imported as the load cases will be required for load combinations and 
analysis results.  

Import / Update 

  

Type of members to create in Revit - This option allows you to specify the type of members to create 
in Revit. The options available are: 

 Analytical – The application will create only the analytical elements in Revit. The properties 
like eccentricity, composite deck info may be lost as the Revit analytical members doesn’t 
have these properties. Boundary conditions, member end fixities, and loads if defined in SCIA 
Engineer will be imported. If this option is selected, the link will not create structural elements 
in Revit.  

 Structural - The application will create only the structural elements in Revit. Boundary 
conditions, member end fixities, and loads if defined in SCIA Engineer will not be imported. If 
this option is selected, the link will not create analytical elements in Revit.  
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 Both structural and analytical - The application will create both structural and analytical 
elements in Revit. The structural elements and the analytical elements will be associated 
automatically. The properties like eccentricity, composite deck info are applied to the 
structural members. Boundary conditions, member end fixities, and loads if defined in SCIA 
Engineer will be imported.  

Please note, this option will not be available in the update process.  

Analysis Results – If this option is set to “Yes”, analysis results will be imported from SCIA Engineer. 
This option will not be available if the “Type of members to create in Revit” option is set as 
“Structural”. 

Ignore generated loads on load panels – If this option is set to “Yes”, only the applied loads on load 
panels will be considered when importing the model from SCIA Engineer. The generated loads on the 
load panels will not be imported. This option will not be available if the “Type of members to create 
in Revit” option is set as “Structural”. 

Ignore reinforcement - If this option is set to “Yes”, the reinforcements are not considered when 
importing the model from SCIA Engineer.  This option will not be available if the “Type of members to 
create in Revit” option is set as “Analytical”. 

Create levels – The levels in Revit are created based on the selected option. 

 Based on Stories – Levels will be created based on the Z coordinates of the stories in SCIA 
Engineer. 

 Based on slab - Levels will be created based on the Z coordinates of the slabs in SCIA Engineer. 

 Based on Z coordinates - Levels will be created based on the Z coordinates of 1D/2D members 
in SCIA Engineer.  

 Use Revit levels – Levels will not be created while importing the SCIA Engineer model and 
elements will instead be attached to the existing levels defined in Revit document. 

Update reinforcement geometry - If this option is set to “Yes”, the application will recreate the 
reinforcement. Setting this option “No” will update the reinforcement size and spacing, but not the 
geometry and other properties. This option will not be available if the “Type of members to create in 
Revit” option is set as “Analytical”. 

Update 2D Member Openings – If this option is set to “No”, the 2D member openings will not be 
updated in the Revit model when importing the model from SCIA Engineer. 

Update member size only - If this option is set to “Yes”, the application will update only the materials, 
types of frames and columns (dimensions of 1D members), thickness of floors and metal decks. 

Update elevation of level based on storey – This option is applicable only if the model was imported 
from SCIA Engineer to Revit and having levels created based on Stories.  In this case, when you update 
the Revit model after making some changes in SCIA Engineer, you have two options to update the 
levels. Setting the option to “Yes” will update the Revit levels based on the Z coordinates of the stories. 
Setting this option to “No” will leave the levels in Revit unchanged. 

If this option is set to “Yes”, the levels which were created based on Stories in the previous import will 
be updated 2D member openings will not be updated in the Revit model when importing the model 
from SCIA Engineer. 

User mapping 

The following user mapping option makes the export option easier when a suitable material is not 
found the members. 
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If the ‘Material as unknown’ is set to “Yes”, the program will not prompt the user for mapping a 
material whenever a material is not found in the mapping database. This option is redundant for 
Timber materials and for all materials in the “File Exchange” mode. 

Mapping details 

CADS Revit SCIA Engineer link is being shipped with pre-installed mapping databases which matches 
cross-sections and materials between SCIA Engineer and Revit.  This database contains the mapping 
for different Revit families and its types with SCIA Engineer sections.  

 

Revit family path 

The default location for the families on your hard drive is C:\ProgramData\Autodesk\RVT 
20xx\Libraries\English\UK.... You may specify the library path in Revit as, 

Revit -> File-> Options-> File Locations -> Places -> 

  

In case, you like to use custom families or would like to use different libraries, you can specify the 
Revit family path using the options “Revit family path”.  
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The application will browse through the specified locations in the order in which the path is specified 
and these families will be loaded into the document during import from SCIA Engineer.  

Mapping tables 

Refer section “Mapping tables” for details. 

Revit Family type mapping 

The Standard steel section family types in Revit are mapped with the section types in SCIA Engineer. 
You may review the family type mapping by clicking on this button “Revit Family type mapping”. Please 
note, this is a read only table. 

  

Layer mapping 

The application will export the members into different layers to SCIA Engineer based on their category. 
The category includes “Frames, columns, Plates and Walls”. For each of these category, the user can 
specify the layer names or optionally load the default names from the standards. This mapping will be 
used only for exporting the model from Revit to SCIA Engineer. 
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4.4 Node format 

 

The “Node Format” can be used to configure the node name when exporting from Revit to SCIA 
Engineer for the first time for each project. 

  

4.5 Export 

The “Export” command exports the Revit model into SCIA Engineer using the current user options. 

 

4.6 Review and export 

The “Review and Export” command can be used to review the current model changes and export the 
selected changes. 



Revit SCIA Engineer Link - Help 

18 
 Copyright © Computer and Design Services Limited 

 

The application opens the review manager dialog that will list the changes to export by comparing the 
current Revit model with the last exported model. If this is a first time export, it will list all the items 
as ‘New’ under the ‘Changes’ column as shown below. 

 

The review manager lists the element ID, member category, cross section, material, type of change 
and an option to export. The preview on the left zooms to show the selected ID.  

The following changes to structural members and openings are tracked by the review manager in this 
release: 

 New - when a new item is available in the current model; 

 Cross section – changes to the cross section (for example UB 305x102x25 to UB 305x127x37 
or wall thickness changed from 200 mm to 300 mm); 

 Dimension – changes to length of 1D members such as beam, column and changes to 
dimensions of 2D elements such as slab; 

 Position - if the structural element is moved from its previous position, including changes in 
eccentricity; 

 Rotation – changes to cross section rotation; 

 Material – changes to material; 

 Member releases – changes to member end releases such as hinges in SCIA Engineer; 

 Opening – changes to opening dimension, position; 

 Delete – when a member is deleted in SCIA Engineer. 

Changes to Loads and Supports are not tracked by the review manager yet. 

Elements deleted from the Revit model will not be listed as the review manager compares just the 
currently available items. 

You can save the contents of the review manager into a file by clicking on the Save log for future 
reference. Clicking on the Export To option in the preview allows you to save the file to multiple file 
formats. 
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Using the selection in the last column (Export) you can choose not to export a particular element by 
un-ticking it.  

4.7 Show Unexported 

 

“Show Unexported” is meant for displaying and selecting the Revit members that are not exported 
after the export process is finished. This command will display the following dialog. 

  

Selecting the required items in the list and selecting Show selects the members in the selection set 
and zooms the selected items to the full extent. 

4.8 Review and Import 

The “Review and Import” command can be used to review the current model changes and import the 
selected changes.  
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The application opens the review manager dialog which could be used to track the changes between 
the SCIA Engineer model and the current Revit model. 

 

You can choose not to import a change by using the option in the last column. This is particularly 
helpful if the changes are specific to analysis.  

During import, CADS Revit SCIA Engineer Link will always update the existing model available in Revit. 
If you are interested to update only the member size of 1D Members, material, Thickness of 2D 
members and Profile sheet, you may choose the option “Update Member size only to “Yes” in the 
Options dialog.  
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4.9 Import 

Selecting “Import/ Update” command imports/ updates the Revit model from SCIA Engineer using the 
current user options. 

 

4.10 Select Imported 

“Select Imported” command can be used to control the entities or the elements that are to be 
imported from SCIA Engineer. 

 

 

4.11 Mapping tables 

The “Mapping Tables” option allows you to create/load /add the mapping data between Revit and 
SCIA Engineer.  
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The application opens the Mapping tables dialog from which you can create/load the mapping of 
materials, cross-sections and profile sheet. Please refer to the section “Mapping tables” for more 
details. 

4.12 Getting started 

 

Selecting “Getting Started” will open the Getting started guide. 

4.13 Best practices 

 

Selecting “Best Practices” this will open the Best Practices guide. 

4.14 Help 

 

Selecting “Help” will open the help document. 

4.15 Check list 
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Selecting the “Check List” command will open the check list document for reporting an issue or a bug. 

4.16 About 

 

Selecting “About” will display the “About box” through which you can verify the version number and 
access the release notes. 
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5 Mapping Tables 

The standard cross section and material libraries in both Revit and SCIA Engineer are comprehensive 
but are labelled differently. CADS Revit SCIA Engineer link is shipped with a pre-installed mapping 
databases which matches cross-sections and materials between SCIA Engineer and Revit. The 
database contains the mapping for different Revit families and its types with SCIA Engineer sections.  

In many cases, in Revit, you may require to use custom families in addition to the standard families. 
In such cases, the pre-defined database which contains the entries of standard mapping is not enough 
to transfer the data between Revit and SCIA Engineer.  

CADS Revit SCIA Engineer link provides a tool “Mapping tables”, to map the custom Revit families with 
equivalent SCIA Engineer materials/ sections. The user defined mapping entries can be stored as a 
”database” and can be used across projects/users. 

“Mapping tables” command can be accessed from ribbon and from the Options dialog. When it is 
accessed from ribbon, you will be able to import/export/save and delete the user defined databases. 
When it is accessed from Options dialog, you will be able review the standard and user mapping 
databases. The following sections will discuss in detail the features of mapping tables. 

5.1 Mapping Tables from Ribbon 

Click on “Mapping tables” command from Ribbon. 

 

The Mapping tables dialog will be shown: 

 

The features of the mapping tables are detailed below. 
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5.1.1 Mapping database 

The application will list all the user defined databases. By default, there will be a blank user table 
(database). You may import the existing database using the option “Import database”. Once the valid 
database is imported, it will be added into the list. 

 

Mapping entities, for both export and import, works on the basis of the database(s) you have selected, 
so you need to select the appropriate database from the list for the transfer to work correctly.  

Please refer to the section” User table” for details of adding/deleting entries into the user table. 

5.1.2 Document mapping 

You can use the “Document mapping” option to map all the materials, sections (standard and 
parametric) and profile sheets that are used in a Revit document in one go. This will avoid the extra 
work involved in having to create individual entries for all materials/ sections of Revit families used in 
the document.  

 

On clicking the “Document mapping” button, the application will read through all the materials/ 
families used in the document and will try to automatically find the equivalent SCIA Engineer materials 
/ sections.  

Please note, the selection of National code is important as the material mapping depends on the 
selected National code. It is recommended to change the National code prior to using the Document 
mapping feature. 
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Material mapping 

Mapping Revit materials with SCIA Engineer materials is primarily based on the material class, National 
Code and the strength of the Revit material. If all the parameters are matched, the application will 
automatically map it to the equivalent SCIA Engineer material. If one or more parameters do not 
match, the application will display the material mapping dialog and you will need to map the 
equivalent materials.  

 

To make the user mapping easier, the program will offer guidance by suggesting equivalent materials. 
The list of suggested materials is made up of those materials which satisfies one or more criterion, 
from which you could pick the desired material. 

 

If you are not satisfied with the suggested list, you can use the “Load all” option to load all the 
materials in SCIA Engineer (filtered based on National code and category) and select the material of 
your choice. 

If the material class in Revit is Concrete, Metal, Masonry, or Wood, the application will, by default, set 
the appropriate category and the user can then select the correct material from the standard list of 
materials that are available in SCIA Engineer for the selected national code. 

If the material class in Revit is “Unassigned or Miscellaneous”, the application will allow you to choose 
any Material category and then any material in that category. Alternatively, you may skip the mapping 



Revit SCIA Engineer Link - Help 

27 
 Copyright © Computer and Design Services Limited 

by checking the “Skip” checkbox. However, in this case you will need to map it during the export or 
chose to export the material as “Unknown”. 

 

The materials that you have mapped will be added into the user table, and will be available for 
subsequent export in other projects. 

Profile sheet mapping 

After the materials are mapped, if metal decks are used in the Revit document, the application will 
then navigate to the “Profile sheet mapping” dialog. Profile sheet mapping is carried out based on pre-
defined rules for the standard steel metal decks with Revit families. Standard profile sheets will be 
loaded based on the National Code and the manufacturer’s product catalogues that are supported by 
the link.   

 

The catalogue name is identified from the family name and deck type is idenfied from the family type.If 
the name of family type matches exactly with the SCIA Engineer deck type, the application will 
automatically map the profile sheets. When the link encounters a family/ family type that is not in the 
SCIA Engineer list, you needs to map the appropraite catalogue name and the deck type. 

Cross section mapping (Standard Steel Profiles) 

After the materials and profile sheets are mapped, the application will then navigate to the “Cross 
section mapping” dialog. Section mapping is carried out based on pre-defined rules for the standard 
steel profile sections with Revit families. 

A simple database is prepared for the standard profile shapes of SCIA Engineer with Revit families. 
This database replaces the multiple databases (2018 and earlier versions of the link) and contains 
mapping for Revit families with SCIA Engineer section types. Based on the family name, the  application 
will find the equivalent SCIA Engineer section type by reading it from the mapping database. After 
finding the section type, the appropraite SCIA Engineer section is identified based on the family type. 
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If the name of Family type matches exactly with SCIA Engineer section, the application will 
automatically map the sections. But, when the link encounters a family/ family type that is not in the 
SCIA Engineer section tables, the application will try to find the near equivalent section(s) and list 
them. The suggested sections will be shown in the Section list. 

 

Based on the parameters of the mapping criteria, it is possible that the application finds more than 
one suitable section. In such cases, the application will list all the possible sections in the Section list 
from which you can pick the desired section. 

 

In case you are not happy with the suggested section list, you can ignore the suggested list. To do so, 
check the “Load all” option and can click on the “Section Name” button to pick any other equivalent 
section from the “Profile library”. 

 

The “Profile library” is a new dialog that has been introduced to show the equivalent standard profiles 
of SCIA Engineer. This dialog lists all the standard sections of SCIA Engineer from wich any standard 
profiles can be selected. The Profile library has filters based on the regions (Country) to make the 
selection easier.  
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Cross section mapping (Parametric mapping) 

Concrete, timber, precast, plate girders, thin-walled and geometric sections, which are defined using 
dimensional parameters, will require their Revit dimensional parameters to be mapped to the 
corresponding SCIA Engineer parameters.   

When such sections are used in the Revit model, the application will group them based on the material 
of the member. The “Group name” is listed based on the group in SCIA Engineer. Please refer to the 
following table which lists material of the member and its group options. 

Material of the element Default Group Group options 

Concrete / Precast Concrete Concrete, Geomteric and Precast 

Wood Timber Timber, Geomteric 

Steel Profile library Profile library, Geomteric, Pairs, Closed, 
Haunch, Sheet Welded, Build-In beams and 
Thin-walled Geomteric. 

For members with “Steel” materials, the default group would be “Profile library”. If you would like to 
use a different group, check the “Load All” button.  

 

Select the group that you would like to use and then click on the “Section Name” button to open the 
parameter mapping dialog.  

The following table lists the section types for each selected group.  

Group Section types 

Concrete Rectangle, I ng, T g ,L g ,L- g ,Circle, Oval 

Geometric I ng, I gh, Rectangle, Circle, Oval, T g, L g, U g, Tube, X, Z, O, C, O 
Asymmetric, Polygon 
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Timber RECT, CIRC, 2 Rect, 3 Rect, T profile, I non-symm, I symm, Box, Box 1, Box 
2,        2 Rect, 3 Rect, Cross, 2+1 El.fill, 2+3 El.fill, 3+2 El.fill 

Pairs 2I, 2Uc, 2Uo, 2LT, 2LX, 2LU, 4LX, 4LU, 2LTn, 2LUn, 2LX , 2xTube, 4xLc, Ivar, 
2CFUo, 2CFUc, 2CFCo, 2CFCc, 2CFLT 

Closed Box fl, Box web, 2U box, 2I box, 2U+2PI box, 2L box, 4L box, U+Pl box, Pl+L 
box, Polygon with hole, I + 2Pl 

Haunch I + I var, I + Pl var, Iw + Pl var, Iw + lw var, Iw + l var, I var, I + lw var, I + 2 I 
var, I cellular symmetric, I cellular asymmetric 

Sheet welded Iw, Iwn, Uw, Tw, Lw, IIw, TTw, Iw+2L, Lw+LI, Iw+Lr, IXw, IXwn, IW+Twl, 
Iw+Twr, Iw + rail, Iwn + rail, SIN1, SIN2 

Build-in beams SFB, IFBA, IFBB, THQ 

Thin-walled geometeric I, RHS, CHS, Angle, Channel, T, Full Rectangle, Full Circle, Asymmetric I, 
Rolled Z, Cold Formed Channel Section, Cold Formed C Section, Cold 
Formed Z Section 

Precast Precast1, Precast2, Precast3, Precast4, Precast5, VSTI - Precast6, Precast7 

Welded, Bridge, Composed 
Symm bridge, Composed, 
Fabricated and Westok 

Not supported. 

Based on the sected section type you chose, the SCIA Engineer parameters will be displayed in a grid. 
You can now map the equivanet Revit parameters for each SCIA Engineer parameter. When you pick 
a Revit parameter, the actual values of the of that Revit parameter is read from the family and listed.  

 

If there equivalent parameters are not available in the Revit family you may set the Revit parameter 
name as “None” and specify the value directly.  

You will need to map the parameters for each family once.  
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Paired sections, SlimFlor beams and Closed sections are mapped by selecting the basic steel section 
profiles from the standard steel section library and then entering the values of the additional 
parameters. 

 

After mapping all the parameters, Click on the “OK” button. The application will create family types 
based on the parameters that you have  mapped. You may review all the family types and the 
respective SCIA Engineer sections in the Parameter mapping tab. 

 

After all the materials, sections, profile sheets in the document are mapped, the application will give 
a message. 

 

The mapping entries are updated to the current user table. The mapping details will be used for all 
subsequent exports/import in the current Revit project (document). You can also Save the user table 
and use it for other projects by using the Import option.  
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5.1.3 Save and Delete database 

All mapped materials, profile sheets, cross sections (standard and parametric) can be saved and 
reused across all your projects and even by other users. Clicking on “Save” command will save the 
entries into the current “User table” (User database). The files will be saved in .xml format. 

By default, the database is saved in... .\Users\xxxxxxx\AppData\Local\CADS\Revit to SCIA 
Engineer\Revit 20xx\Mapping Databases\.......xml. 

 
 
You may delete the database, by clicking on the “Delete database” button. If you have only one user 
table (database), the delete database button will not be shown. There should be at least one user 
table to be present. 

 

5.1.4 Import/Export database 

You can import any user mapping database by clicking on the “Import database” button.  
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To import a user table (database) that has been saved elsewhere, click on the “Import database” 
button and select the file(s). The files will be copied into “..:\Users\xxxxxxx\AppData\Local\CADS\Revit 
to SCIA Engineer\Revit 20xx\Mapping Databases\”. Any changes to the entries will be effected into 
this copied file and the original file will not be altered. 

The imported databases will be used across the Revit projects for the user. If you need to use it across 
different users/ systems, you need to share the file. This could be achieved by using the “Export 
database” command. 

 

By clicking on this, you are prompted to specify the file name in the standard browser dialog.  

5.2 Mapping tables from Options dialog 

The “Mapping tables” can also accessed from the “Options” dialog.  

 

The Mapping tables dialog when it is accesses from here will list the standard pre-installed databases 
that are shipped with the CADS Revit SCIA Engineer Link along with the User Table used in the 
document.  

You can use this feature to review the mapping of default Revit families (Materials, Profile sheet and 
Virtual joists) to the corresponding default SCIA Engineer materials/sections and the user mapping. 
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Select the database type as “General” and select the “General-Materials” database, will list the 
mapping of Revit materials and the corresponding SCIA Engineer materials. Selecting the “General- 
Profile Sheet” database, will list the mapping of Revit metal decks and the corresponding SCIA 
Engineer decks. 

 

In the same manner, you can review the mapping of Virtual Joists, and Joist girders. 

In addition to above, when you select the type as “User”, the database will be set to “User table” used 
in the current Revit document (project).   

 

Please refer to the section “User Mapping” for more details regarding the user table. 

5.3 User Table 

If you use custom families for cross-sections, profile sheets, materials, it is required to map the 
equivalent SCIA Engineer entities and this can be achieved through user mapping. The mapping details 
(entries) are stored in “User tables”. The user tables are used along with the pre-installed databases 
during export and import process. 
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5.3.1 Adding mapping entries into User Table 

Clicking on the cell adjacent to the * button allows you to add your customised mapping for the 
material/ cross-section/ profile sheet under respective tab. 

For material mapping, you will need to specify the material category (by selecting it from the combo), 
choose the relevent material name and specify the equivalent SCIA Engineer material.  

 

Revit materials in the document will be listed based the material class and SCIA Engineer materials will 
be listed based on the National code.  

For Family (Cross-section) mapping, you need to select the Revit families and the equivalent SCIA 
Engineer section types.  

 

If you wish to map the customised Revit families or would like add/change the library, it is 
recommended to add the path where the families are stored in any of the following places using the 
“Add” option. 

Revit -> File -> Options -> File locations -> Places Or Revit -> CADS -> CADS Revit SCIA Engineer Link -> 
Options -> Revit Family path 

The last subfolder(s) of the selected path will be listed under “Category”and the Revit families will be 
listed under “Family name” based on the selected family role. You need  to add your custom families 
into seprate folders “Structural Framing” and “Strcutural Columns” according to their family role.  

The Cross-section mapping is dedicated to standard profiles and hence using this option you will be 
able to map only the equivalent standard sections (and not those defined with their dimensional 
parameters) in SCIA Engineer in the “Profile library” dialog. This dialog will be shown on clicking the 
section name button in the dialog. 
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For families which are defined with dimensional parameters, use “document mapping” option. You 
will not be able to add mapping entries for paramteric sections in the user table directly.  

Mapping standard metal decks is similar to the material mapping and you can add entries to the user 
table as described in the previous paragraphs.  

 

5.3.2 Delete entries from User Table 

The entries added in the user table can be removed by deleting them using the “Delete” button or 
alternatively using the “Delete” key on your keyboard. The standard selection methods can be used 
to select and delete multiple entries in the list. 
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5.4 Mapping during Export/Import 

During the Export/Import process, CADS Revit SCIA Engineer Link application will find the equivalent 
materials/ profile sheet / cross- section, by verifying the pre-installed databases and then by reading 
through the selected user table.  You will be prompted to do a manual mapping only if the link 
application encounters a material / section / profile sheet that cannot be resolved from the pre-
installed database. 

5.4.1 User mapping during Export (Revit – SCIA Engineer): 

The user mapping during export is very similar to the one detailed in the section “Document mapping” 
with the following exceptions: 

 You will not be able to use the “Skip” option in the material mapping.  You could, however, 

export the materials as “Unknown”.  

 
 While performing a cross-section mapping, you have the option to export the section as 

“General section” or “Numerical section”.  

 

5.4.2 User mapping during Import (SCIA Engineer - Revit): 

The user mapping during import, has a slightly different interface than that of the export. The columns 
in the user mapping table will be rearranged so that the user specifies the equivalent Revit 
material/family for the selected SCIA Engineer material/section. 

While importing the model from SCIA Engineer, the application will read the SCIA Engineer object and 
find the equivalent Revit family and its types by reading through the pre-defined databases and user 
tables. Once the Revit family is identified, the family and its types will be created in Revit by loading 
appropriate family and its type in the Revit document. The application will try and search the family 
files (.rfa) in the library path and the Revit family path listed in the below locations. 
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Revit -> File -> Options -> File locations -> Places Or 
Revit -> CADS -> CADS Revit SCIA Engineer Link -> Options -> Revit Family path 

Hence, it important to specify the location of family files correctly. It is also important to choose the 
appropriate Revit template as the Revit materials and sections are first read from the document. 

If the application couldn’t find the equivalent Revit family, it will prompt you to map the Revit family 
and its types. 

Form material mapping, the Revit materials will be listed based on the selected database. You can 
select the “Load All” option to load all the supporting databases.  

You may skip the material, but please note that in such cases, the elements that uses the skipped 
materials will be ignored during import. 

 

For standard steel profile sections, the group name will be shown as “Profile library”.  
The application will identify the family name, will load the family type by reading the text file and 
create the members in Revit.  

If the application couldn’t find the Revit families, a warning sign will be shown for such sections. In 
such cases, you can check the “Load all” option and select the appropriate database (Revit family path) 
and choose the appropriate family and the family type. 

 

The application will list the families which are available in the selected path. The list of family types is 
based on the types listed in the selected family. If the user chooses the “Document –families”, he will 
be allowed to select any of the family and its type from the document (Revit project). 

While importing the sections (Concrete, Geometric, Thin-walled, Pairs, Closed, etc.,) which requires 
the parameter mapping, the parameters needs to be mapped to create the family types. The 
application will try to find the equivalent family within the Revit project document and if it is not 
found, the application will use the pre-installed CADS families.  
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The parameters will be automatically mapped for the CADS families and some of the standard Revit 
families. 

You could change the family to be used by using the “Load all” option and choosing the appropriate 
databases.  

If you choose “Document families – Parametric”, then you will need to map the individual parameters 
between SCIA Engineer and Revit.   

To summarise: 

Name of Database Action 

CADS families Mapping of the parameters is automatic, no user action is required. The types will 
be created according to the values. 

Document families - 
Parametric 

The user needs to map the parameters* once. The value of parameters will be 
updated and new type will be created if needed. 

Document families The user maps the family type and the family type is directly used. 

*If the document families are of standard Revit families, the parameters will be automatically mapped. 

(For user defined families of Build-in beams, Paired sections and closed sections alone, you will not be 
able map the profiles, but will need to map the dimensional properties of the section profiles with 
Revit parameters.) 

While importing the profile sheets from SCIA Engineer, the standard profile sheets are automatically 
imported using the pre-installed CADS families. The user defined profile sheets can be imported by 
mapping them with the CADS families. 
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6 Import analysis results from SCIA Engineer 

Results are imported from both 1D members (member) and 2D members (surfaces) from all available 
load cases and combinations. 

The results imported include: 

1. Support reactions: 

 Reactions (Fx, Fy and Fz) in global directions 

 Support moments (Mx, My and Mz) about global directions 

2. Member results: 

 Member internal effects (Fx, Fy, Fz, Mx, My and Mz) 

 Member displacements (Ux, Uy and Uz) 

3. Surface results: 

 Membrane forces (Nxx, Nyy and Nxy) 

 Shear forces (Qxx and Qyy) 

 Moments (Mxx and Myy) 

(Results for surfaces are obtained using the in-nodes average option from SCIA Engineer). 

4. Deformations (Deformed structure) 

Import of stresses and rotations are not supported for both 1D and 2D members (members and 
surfaces).  

Please refer to Autodesk Revit help on Assumptions for visualisation of results for surface objects and 
Available type of results 

6.1.1 Co-ordinate system: 

The global co-ordinate system and the local co-ordinate system for members (1D member in SCIA 
Engineer) and surfaces (2D member in SCIA Engineer) can be displayed in Revit by selecting the option 
in the results manager. 

Revit and SCIA Engineer follow the same conventions for the Global co-ordinate system. 

 

6.1.2 Importing analysis results 

To enable the import of analysis results, set the input for Analysis results under Import to Yes. 

Note that importing analysis results could take considerable time and depends upon the size of the 
job, number of load cases, presence of 2D members etc. Hence it is best to try with a few combinations 
and a reduced model initially. 

http://help.autodesk.com/cloudhelp/2023/ENU/Revit-Analyze/files/GUID-4563C508-003F-4D52-A836-81D342771FF7.htm
http://help.autodesk.com/cloudhelp/2018/ENU/Revit-Analyze/files/GUID-31256971-F389-40FD-9812-EC305A773A31.htm
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For “envelope” combinations, the max and min values will be shown in Revit. If you need the 
combination results, explode the combinations into linear and import them into Revit. 

 

 

6.1.3 Viewing the analysis results 

Once the import of the model is completed, click on Results Manager from the Analyze tab in the 
Structural Analysis group. 
 

 

When imported with results an entry will be available in the results manager to show that the results 
are up-to-date along with the date and time of the import. CADS Revit SCIA Engineer Link will be 
displayed under the “Provider” column of the Results Manager. 
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The option to view results is available in the results explorer which can be launched from the review 
manager by clicking on Explore or by directly selecting the Results Explorer option in the Analyse tab 
under Structural Analysis group. 

It is recommended that you view the results on the analytical model. 

It is possible to store and compare multiple sets of results from Revit. Hence the Results Explorer has 
options to choose the model, analysis set and load case to view the result. Load combinations are also 
listed. 

  

Select the required result type and click on Apply at the bottom of the dialog to view the result. 

The load case list displays all the load cases including the ones available in Revit by default. In many 
cases the structural engineer may create their own load cases in SCIA Engineer rather than using the 
ones imported from Revit. In such cases the load cases originally created in Revit but not used in SCIA 
Engineer will not have any results. 

The following message will be displayed on selecting those load cases for which no results are 
available. In this case close the message and select a load case which is used in the SCIA model. 
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For 2D members, the results from SCIA Engineer are exported using In nodes, avg (average) option. 
There is no user option to modify it. 
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6.2 Beam reactions 

On importing analysis results from SCIA Engineer, beam end reaction (shear) can be included as 
annotation tags. The value reported is the maximum shear (Vz) at member start and end from all the 
available combinations. 

To add the end reactions to beam annotations: 

1. Select the plan view of the Level. 

2. Click Beam Annotations from the Annotate tab. 

 

 The Beam Annotations dialog box is displayed. 
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3. Click the browse button (three dots) to the right of the label name. 

4. Select the Structural Framing Tag option. 

 

5. Select the annotation type as Start Reaction Tag for the start position of the beam and End 
Reaction Tag for end from the Type drop down list. The start reaction tag and end reaction 
tag families are loaded into the project during import. 

6. Click OK. 

7. The start and end reactions will be shown in the plan view. 

 

8. Click the Options button to specify the vertical and horizontal offset for the tag(s) in the 
Placement Settings dialog box.  
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Please note, the Beam annotations can be created only in the plan view.  

6.3 Importing Design info from SCIA Engineer 

The design information for composite beams and virtual joists can be imported from SCIA Engineer to 
Revit. Composite design data includes the studs, camber, moments and shear forces at the ends of 
the member. For virtual joists, the joist designation, moments and shear forces at the ends of the 
member will be imported into Revit as properties of the members.  

 

The design info (composite beam design info and virtual joist design info) is available as an attribute 
of the member. Studs and camber info are imported to Revit as properties of the “Structural frames”,  
Joist designation is imported as “comments” and moments & shear forces at ends are imported into 
Revit as “Member forces”. For Joist girders, in addition to above, the number of spacing and the point 
load will be updated in the property “SpaceNum” and the Panel poinbt load respectively. 
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7 Round trip 

7.1 Step 1 – Create the model in Revit 

This example explains the round trip between Revit and SCIA Engineer. 

Create the model in Revit structure as shown below. 
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7.2 Step 2 – Export to SCIA Engineer 

Export the model to SCIA Engineer using the “Export to SCIA Engineer” command. The exported model 
is shown below. 

 

 

 

7.3 Step 3 – Analyse / Design in SCIA Engineer 

Do the analysis in SCIA Engineer and optimise for size / geometry configuration etc. 
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For instance, the size of the two columns shown below is reduced from 200x600 mm to 200x450 in 
the SCIA Engineer model. 

                    

Size of the column = 200x600 --------------- Size of the column after modification = 200x450 
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7.4 Step 4 – Update from SCIA Engineer 

Update the model back into Revit using the “Import / Update” command. 

The column sizes in Revit are shown before and after the update process. 

                               

Size of column - Before updating = 200x600 ---------- Size of column – After updating = 200x450 
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8 Features matrix for Revit link (Appendix) 

The following table lists how the physical Revit Structural objects are transferred between Revit and 
SCIA Engineer: 

Main items Sub items Revit to  

SCIA Engineer 

SCIA Engineer to 
Revit 

Comments 

  

New Update New Update 

 

Grid 

 

n/p n/p n/p n/p  

Levels 

 

n/p n/p Yes Yes Levels in Revit are created 
based on Stories/ Position of 
Slabs/ Z coordinates of 
members in SCIA Engineer. 

Materials Steel, Concrete, 

Timber (Euro, 
IBC),  Masonry 
(Euro) 

Yes Yes Yes Yes 

 

Timber and 
Masonry (BS, 
LRFD, NEN) 

n/p n/p n/p n/p No material available in SCIA 
Engineer 

By Category Yes Yes n/a n/a Material set as ‘By Category’ in 
Revit will now be exported to 
SCIA by mapping to an 
equivalent SCIA Engineer 
material set for each category 
(Concrete, Steel, Timber).  

Cross-sections Standard steel 
sections (Profile 
library) 

Yes Yes Yes Yes Most of the standard families 
are auto mapped with the 
sections in SCIA Engineer. 
Some of the families might 
need user mapping. 

Pairs, Closed, 
Haunch, Sheet 
welded, Build-
in beams, Thin-
walled 
geometric 
sections 

Yes Yes Yes Yes  Revit - SCIA -> Based on user 
mapping (Parameters).  

SCIA – Revit-> Comprehensive 
list of CADS Families supplied 
with the link will be used by 
default.  The available family 
files are deployed in 
C:\ProgramData\CADS\Revit 
to SCIA Engineer\Revit 
xxxx\Revit Families 

Concrete 
Sections: 

I ng 
(Asymmetric I 
Section), 
Rectangle, 
Circle, Oval, T g, 

Yes Yes Yes Yes Revit- SCIA -> Based on user 
mapping (Parameter 
mapping). 
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Main items Sub items Revit to  

SCIA Engineer 

SCIA Engineer to 
Revit 

Comments 

L g, Lg (Inverted 
L) 

Timber 
sections: 

Rectangle, 
Circle, 2 
Rectangles, 3 
Rectangles, T 
profile, Cross, 2 
+1 EI. Fil, I non-
symmetric, I 
symmetric, Box 

 

Yes Yes Yes Yes Revit- SCIA -> Based on user 
mapping (Parameters).  

SCIA – Revit->Comprehensive 
list of CADS Families supplied 
with the link will be used by 
default.  The available family 
files are deployed in 
C:\ProgramData\CADS\Revit 
to SCIA Engineer\Revit 
xxxx\Revit Families 

General 
sections 

n/a n/a Yes Yes The cross section mapping 
with Revit family cannot be 
saved with the Section 
mapping table, but has to be 
mapped during the 
export/import process. 

Numerical 
sections 

n/a n/a No No Numerical sections from SCIA 
Engineer can be imported by 
mapping to the Revit families. 

Precast 
Sections 

Single T 
(Precast 1) and 
Double T 
(Precast 2) 

 

Yes 

Yes 

 

Yes 

Yes 

 

Yes 

Yes 

 

Yes 

Yes 

 

Geometric 
Shapes: 

I ng 
(Asymmetric I 
Section), I gh (I 
Section), 
Rectangle 

Circle, Oval, T g, 
L g, U g (C 
Section), Tube, 
X, Z, O, C (Box C 
Section), O 
Asymmetric 

Yes Yes Yes Yes Geometric sections are 
created based on parameter 
mapping and are dependent 
on the materials used. 

2D Members 2D Element - 
Ribbed Slab 

n/a n/a Yes Yes Mapped as two different 
elements in Revit. 

Load panel n/a Yes*  Yes Yes *Load panels are imported to 
Revit as Floors and are 
updated back to SCIA as load 
panels. Vertical and inclined 
panels are not supported. 
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Main items Sub items Revit to  

SCIA Engineer 

SCIA Engineer to 
Revit 

Comments 

National Code BS, EC-EN, EC-
ENV, NEN 
(Metric) 

IBC, IBC (Metric 
and Imperial) 

Yes n/a n/a n/a Materials are mapped 
according to the National 
code. 

Column Rotations Yes Yes Yes Yes 

 

Start/end 
points 

Yes Yes* Yes No *Extra nodes will not be 
deleted in SCIA Engineer 

Analytical 
Alignment 

Yes Yes n/a n/a Only ‘Auto Detect’ is 
supported. 

Material Yes Yes Yes Yes 

 

Member end 
releases 

Yes Yes Yes Yes 

 

Frame Rotations Yes Yes Yes Yes * Alpha rotation is not 
supported. 

Start/end 
points 

Yes Yes* Yes No *Extra nodes will not be 
deleted in SCIA Engineer. 

Analytical 
Alignment 

Yes Yes n/a n/a 

 

Material Yes Yes Yes Yes 

 

Structural 
Usage 

Yes Yes Yes Yes 

 

Member end 
releases 

Yes Yes No No 

 

Z direction and 
Lateral 
Justification 

Yes Yes Yes Yes Subject to Revit limitation. 

Brace Rotations Yes Yes Yes Yes 

 

 

Start/end 
points 

Yes Yes* Yes No *Extra nodes will not be 
deleted in SCIA Engineer. 

Analytical 
Alignment 

No No No No 

 

Material Yes Yes Yes Yes 

 

Structural 
Usage 

Yes Yes Yes Yes 

 

Member end 
releases 

Yes Yes No No 

 

Curved beams Circular arc Yes Yes Yes No 

 

Ellipse Yes No No No 

 

Spline Yes Yes No No 

 

Truss 

 

Yes Yes n/p Yes 
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Main items Sub items Revit to  

SCIA Engineer 

SCIA Engineer to 
Revit 

Comments 

Beam System 

 

Yes Yes n/p Yes 

 

Composite 
Beam 

Composite 
beam as simple 
beam 

Yes Yes n/a Yes  

Composite 
beam and slab 
data 

No No No No  

Camber and 
number of 
studs 

No No Yes* Yes* * This works only when the 
design info is stored with the 
member in SCIA Engineer 

End forces No No Yes* Yes* 

Steel bar joist Steel bar joist Yes Yes Yes Yes Steel bar joists are mapped as 
virtual joists. 

Joist 
designation 

n/a n/a Yes* Yes* * This works only when the 
design info is stored with the 
member in SCIA Engineer. The 
data for SpaceNum and Panel 
Point load are read from the 
“Comments” in the Design info 
of SCIA Engineer. 

End forces No No Yes* Yes* 

SpaceNum and 
Panel Point 
load 

No No Yes* Yes* 

2D Members - 
Slab 

Linear, Curved 
Edge 

Yes Yes* Yes Yes# *Extra nodes will not be 
deleted in SCIA Engineer. 
#Only section sizes and 
material property updated, 
change in geometry not 
updated back to Revit. 

Change in 
number of 
edges 

n/a n/p* n/a No *Limitation in SCIA Engineer. 

Holes Using 
"Edit" slab 
option and 
drawing a hole 
profile 

Rectangular, 
Circular, 
Polygon 

Yes Yes n/a n/a 

 

Holes using 
"opening" 
command 

Rectangular, 
Circular, 
Polygon 

Yes Yes Yes Yes *Openings can also optionally 
be exported as panels. 

Thickness 

 

Yes Yes Yes* Yes* *Multiple layers as  

Single thickness. 

Material Yes Yes Yes Yes 
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Main items Sub items Revit to  

SCIA Engineer 

SCIA Engineer to 
Revit 

Comments 

Varying 
thickness in 
several 
directions 

n/p n/p n/p n/p No equivalent type in SCIA 
Engineer. 

Varying 
thickness in one 
direction 

No No No No 

 

Out of plane arc 
(i.e. curved 
slab) 

No No No No 

 

Sloped slab Yes Yes Yes No 

 

Spline edge Yes Yes Yes Yes# #Only section sizes and 
material property is updated, 
change in geometry is not 
updated back to Revit. 

Shaft openings Yes Yes n/a n/a Since there is no equivalent 
opening in SCIA Engineer, 
openings are created 
separately for each floor level 
and there is no association 
between them in SCIA 
Engineer. 

2D Members – 
Composite slab 

Composite slab Yes Yes Yes Yes  

Metal deck Yes Yes Yes Yes  

2D Members - 
Wall 

Linear, Curved 
Edge 

Yes Yes* Yes No *Extra nodes will not be 
deleted in SCIA Engineer. 

Change in 
number of 
edges 

n/a n/p* n/a No *Limitation in SCIA Engineer. 

Holes Using 
"Edit" wall 
option and 
drawing a hole 
profile 

Rectangular, 
Circular, 
Polygon 

Yes Yes n/a n/a  

Holes using 
"opening" 
command 

Rectangular 

Yes Yes Yes Yes  

Circular n/p n/p n/a n/a  

Polygon n/p n/p n/a n/a  

Thickness Yes Yes Yes Yes 

 

Material Yes Yes Yes Yes 
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Main items Sub items Revit to  

SCIA Engineer 

SCIA Engineer to 
Revit 

Comments 

Out of plane arc Yes Yes Yes No 

 

Stacked wall Yes n/p* n/a n/p* *One physical wall has two 
FEM members 

Curtain wall n/a n/a n/a n/a 

 

Stepped 
bottom 

Yes Yes Yes Yes 

 

Boundary 
Conditions 

Point boundary 
conditions for 
columns and 
beams 

Yes Yes No Yes 

 

Line boundary 
condition for 
slabs 

Yes Yes No Yes 

 

Line boundary 
condition for 
beams 

No No No No 

 

Area boundary 
condition 

Yes n/a Yes n/a Surface support (el. 
Foundation). 

Stiffness for 
boundary 
condition 

Yes Yes No Yes 

 

Reinforcement   Reinforcement 
– 1D  

No No Yes Yes* * If the reinforcement is 
deleted in SCIA Engineer, 
updating the Revit model will 
not delete the reinforcement. 

 Reinforcement 
– 1D (Practical)  

Yes No Yes Yes* For the supported sections. 

 

 Reinforcement 
– 2D 

No No Yes Yes*  

Foundations Isolated as fixed 
boundary 
condition 

Yes n/a n/a n/a 

 

Isolated as 
foundation 
block 

Yes Yes n/a n/a 

 

Wall foundation 
as boundary 
condition 

Yes n/a n/a n/a 

 

Wall foundation 
as foundation 
block 

n/p n/p n/p n/p No equivalent feature in SCIA 
Engineer. 

Wall foundation 
for stepped 
wall 

Yes n/a n/a n/a 
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Main items Sub items Revit to  

SCIA Engineer 

SCIA Engineer to 
Revit 

Comments 

Slab as fixed 
boundary 
condition 
(usage = 
foundation) 

Yes* n/a n/a n/a * Line or point support 
depending on structural 
element supported. 

Slab as Raft + 
Sub grade 

Yes Yes n/a n/a It can be exported as ordinary 
2D Element to SCIA Engineer. 

Loads Free point load Yes Yes Yes Yes 

 

Free line load Yes Yes Yes Yes 

 

Free area load Yes Yes Yes Yes 

 

Hosted point 
load 

Yes Yes Yes* Yes *Hosted point load on Beam is 
not supported in Revit. There 
might be duplicates when 
there are more than one 
member connecting on a 
node. 

Hosted line 
load 

Yes Yes Yes* Yes *Hosted part load on beam 
and member edges not 
supported in Revit. They are 
imported as free loads in Revit. 

Hosted area 
load 

Yes Yes Yes Yes 

 

Load cases Dead, Live, 
Wind, Snow, 
Roof, 
Accidental, 
Temperature, 
Seismic 

Yes n/a n/a n/a 

 

Self-weight n/a n/a Yes n/a 

 

Temperature 
(LRFD code) 

No 

   

No equivalent feature in SCIA 
Engineer. 

Seismic (BS 
code) 

No 

   

No equivalent feature in SCIA 
Engineer. 

Load 
Combination 

Combinations 
of load cases 

Yes Yes Yes* Yes *There are issues in Revit API, 
therefore to retain the load 
combinations SCIA Engineer 
does not export load 
combinations from Revit. 

 

Combinations 
of 
combinations 

No No No No No equivalent feature in SCIA 
Engineer. 

Rigid arm 
/Analytical 
links 

Rigid arm 
/Analytical link  

Yes Yes Yes Yes  Analytical links in Revit are 
exported as Rigid arms and 
vice versa. 
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Main items Sub items Revit to  

SCIA Engineer 

SCIA Engineer to 
Revit 

Comments 

Deleting of 
members 

 

Yes Yes Yes Yes  

 

Partial 
selection 

 

Yes Yes No No 

 

Moving 
elements 

 

Yes Yes Yes* Yes* *Limitation with SCIA Engineer 
“Move” operation. 

2D members are not 
supported. 

Truss members & Beam 
Systems are not supported, 
but the member locations get 
updated automatically in Revit 
if they rest on columns due to 
Revit constraints. 

Free point loads and free area 
loads are not supported. 

Default Revit error message is 
displayed when the column is 
moved in SCIA Engineer but 
not the members constrained 
to the column. 

 

Legend 

n/a  Not applicable 

n/p   Not possible 

Yes   Implemented 

No   Not implemented 
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9 Technical Support 

 Computer and Design Services Ltd 

Arrowsmith Court 

10 Station Approach 

Broadstone 

Dorset BH18 8AX 

 Tel. +44 (0)1202 603031 

 E-mail support@cads.co.uk 

 

 SCIA NV 

Corda 2 

Kempische Steenweg 309/0.03 

BE-3500 Hasselt 

BELGIUM 

Telephone: +32 11 948610 

E-mail: info@scia.net 

  

 SCIA NEDERLAND B.V. 

Goeman Borgesiuslaan 77 

3515 ET Utrecht 

NETHERLANDS 

Tel: +31 26 320 1230 

E-mail: info@scia.net 

 

 SCIA CZ, s.r.o. 

Evropská 2591/33d 

Praha 6 

CZECH REPUBLIC 

CZ-160 00 

Tel: + 42 226 205 600 

E-mail: info@scia.net 

mailto:support@cads.co.uk

